
How to Podcast Sermons
by James Cooper (of Minehead Baptist Church – www.minehead-baptist.com or http://jpc-design.com)

More and more churches are putting their sermons online.  But if you're not a geek or very techy 
minded, it can be a very scary thing!  So in this article I'll be explaining the process; from the 
recording of the sermons, editing sermons and 'MP3-ing' them, putting sermons online and then 
making them available to the whole world on a website and as a podcast through a feed and the 
iTunes store!

Recording Sermons

There are different ways of recording sermons, including recording onto CD, using a digital 
recorder, recording straight onto a computer and using a good old cassette recorder!

Recording onto CD

If you use a CD recorder in the Church for recording the services – great!  To edit the CD (e.g. 
extracting just the sermons/readings) you'll need to 'rip' the CD in a computer. Programs such as 
Windows Media Player (WMP), Winamp and iTunes (my favourite) can all do this.

When ripping CDs, for this purpose, I recommend that you rip it to a .wav (PC) or .aiff (Mac) file. 
Warning, these files will be large (500mb+ for your average CD), but you'll get the best quality for 
editing.

To import a CD into iTunes: http://support.apple.com/kb/HT1473 
For how to set the import file type in iTunes, see the 'convert file' link for iTunes below.

To import a CD into WMP: 
http://www.microsoft.com/windows/windowsmedia/knowledgecenter/howto/mp11/rip.aspx
To import a CD into Winamp: 
http://media.winamp.com/main/help/50/Saving_CDs_to_Your_PC.htm

When you've got your big file, from the CD, you're ready for editing!

Using a Digital Recorder

I use a digital recorder for recording our sermons at Church for podcasting. Some MP3 players have 
a 'line in' feature and you can use this to record the sermon. I use an old Creative Zen Nano Plus. 
The current Creative Zen V series feature a line in for recording 
(http://www.creative.com/products/mp3/). Many of the iRiver mp3 players (http://www.iriver.com/) 
also feature line ins.

If you want to do serious digital recording, the M-Audio MicroTrack II might be a good option 
(http://www.m-audio.com), and the Zoom H2 and H4 are also meant to be excellent 
(http://www.zoom.co.jp/english/products/h2/). The two from Zoom also have very good quality 
external microphones built into them.
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The best way to use a digital recorder is to plug it into an output on a mixing desk. Most mixing 
desks have 'aux' or 'send' outputs. If you can plug the recorder into one of these, you should get a 
really good quality. You might need some adapter cables to make the connection. It's hard to say 
what you'll need because it depends on how you're going to be plugging it in! It's worth doing some 
demo recordings to check the sound level as some line ins can be rather sensitive!

Digital Recorders 'encode' the audio into a variety of formats including MP3, WMA (windows 
media audio) and WAV.

You'll firstly need to download the file from the digital recorder onto your computer (normally done 
by USB)

If you've got a wav file, you're ready for editing and the next post in the series!  If you've got an 
MP3 or WMA file, I recommend converting them to a WAV/AIFF so you get the best quality audio 
for editing.

You can convert the files in a similar way to the CD using WMP, Winamp or iTunes

To convert a file in iTunes see: http://support.apple.com/kb/HT1550

To convert a file in Winamp: 
http://www.audiotoolers.com/ubbt/ubbthreads.php/topics/7262/Tutorial_How_to_convert_MP3_fi.h
tml (primarily for files, but is the same idea for cds!)

I've can't find an easy way to convert file types within WMP, if you know of a way, please leave a 
comment! I think iTunes is the easiest way to do the conversion.

Once you've got your WAV/AIFF file, you're ready for editing!

Recording Straight onto a Computer or Using a Good Old Cassette Recorder/Player:

These methods are could be seen the most 'techy' (recording straight in) and the most basic (the 
tape), yet strangely there are quite a few similarities between them!

For both on them you will need a way of getting the audio into the computer. Most 
computers/notebooks have 'mic' sockets on them. You can use these, but they are normally only 
mono and the quality can be rather 'buzzy/crackly'! If your computer has a 'line in' socket, this is 
much better and they're often in stereo. These sockets are normally 3.5mm (headphone size).

Other alternatives include soundcards (where you take the computer to bits to install them!) and 
external USB and FireWire 'audio interfaces'. These will often give you better control and quality 
but can cost more.

One of the most popular, and simplest, external 'boxes' is the griffin iMic: 
http://www.griffintechnology.com/products/imic/ It's got in and out 3.5mm jacks and plugs into the 
computer by USB.

Behringer also make a simple and very affordable USB interface which has got RCA/Phono imputs 
rather than a 3.5mm jack. This could be just what you want if you're connecting from cassette desk 
or stereo output from a mixing desk: http://www.behringer.com/EN/Products/UCA202.aspx
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You can even not get a USB Cassette Deck! http://www.zzounds.com/item--IONTAPE2PC  (USA)
http://www.firebox.com/product/1849/USB-Cassette-Deck  (UK)

If you want to push the boat out a bit, there are many excellent interfaces by M-Audio (www.m-
audio.com USB), PreSonus (http://www.presonus.com USB and FireWire) and Behringer 
(http://www.behringer.com USB and FireWire)

I started by plugging an old cassette walkman into the mic socket on my laptop using a 3.5mm lead, 
as this was all I had! I now use a Behringer FireWire FCA202 
(http://www.behringer.com/EN/Products/FCA202.aspx), this is a bit geeky as you also need a 
mixing desk to get the audio into it (I use an old version of one of these: 
http://www.behringer.com/EN/Products/802.aspx), but then I am geek!

Again, you'll need some cables to connect things. But without know what you're plugging from and 
to, it's hard to recommend things.

To record either directly or from a tape, you need some software to capture the audio.

Audacity (http://audacity.sourceforge.net/) is an excellent free program for Windows, Mac and 
Linux that will do the job really well. If you use a Mac, Garageband is also a good option.

You need to either play the tape, or get the direct line and record it 'live' into the software.

This is a good guide for Audacity: 
http://audacityteam.org/wiki/index.php?title=Transferring_tapes_and_records_to_computer_or_CD

These are good basic guides for Garageband:
http://docs.info.apple.com/article.html?artnum=93701 (configuring iMic, but it's the same for most 
audio inputs)
http://docs.info.apple.com/article.html?path=GarageBand/4.0/en/9109.html (basic recording in 
Garageband)

If you have to use the 'mic' socket, especially in Windows, be careful with options such as 
'microphone boosts' as this can lead to distortion!

When you've recorded your tape/direct line, you should have a nice file (it's a good idea to save it as 
a 'project' in either Audacity or Garageband) that's ready for editing.

Editing and MP3-ing the Sermons

Using Audacity (Windows/Linux/Mac)

Audacity can do some pretty clever editing, but most of the time you'll only need to do simply 
editing.  When you open audio within Audacity, you'll see the audio as a wave form with lots of 
wiggly lines (a technical term!). You can use the zoom icons (they look like magnifying glasses) to 
zoom in and out, so you can have more or less in time on the screen.
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Cutting out 'dead audio' (such as before and after the sermon and any very long silences within a 
sermon) is very easy indeed. Simply click and drag a 'region' in the audio and hit the delete key and 
that region is gone. The audio before and after the deleted region close up so there's no gap.

One of the most powerful tools within Audacity is 'Noise Removal'. This can be especially useful if 
you've recorded from a cassette, as you can normally get rid of most of the tape 'hum'. There's a 
very good guide at: http://audacityteam.org/wiki/index.php?title=Noise_Removal

You might also want to fade the beginning and end of the sermon in and out. This can be simply 
done by selecting the region of audio you want to fade (again by click and drag) and then choose 
'Effect => Fade In' or 'Effect => Fade Out'. If you need to add some silence in somewhere, click in 
the audio to get a 'place head' (click in the wave form) and choose 'Generate => Silence' and choose 
an amount of time.

If the whole recording is too loud or quiet you can either select a region or all the audio ('Edit => 
Select All') and use 'Effect => Amplify'. But be careful, when amplifying up, you can easily make 
things too loud and distorted!

You might want add an intro or outro to the sermon saying where the sermon's from (your Church!), 
who's speaking, what the sermon's about and any readings, etc.

With Audacity, I find it best to do a 'File => New' and record the intro/outro in there and then select 
it all and copy it and then paste into the front/end of the sermon audio (put the place head where you 
want and then paste).

Like recording the sermons, there are a few different ways you could record the intro/outro. These 
include a webcam mic, a digital recorder or a 'proper' mic and audio set-up. For more on this, see 
the section at the end of the post.

Once you've got you sermon all edited and ready to go, you need to 'encode/save' it as an MP3 file. 
To encode/save as an MP3 in Audacity, you might need to install a special file known as LAME. 
(Later versions of Audcity for Windows have MP3 encoding build it.) More information on how to 
install LAME: http://audacityteam.org/wiki/index.php?title=Lame_Installation

MP3 files can be encoded at different qualities, known as 'bit rates'. You can choose the quality in 
'Edit => Preferences => File Formats' (win); 'Audacity => Preferences => File Formats' (mac). The 
smaller the number, the smaller the file but the quality will be lower. I encode the MP3s at 56kbps 
(kilo bytes per second), as I think this is a good balance balance of size/quality. At 56kbps, a 30/40 
min MP3 is about 12-15mb in size.

Music needs to be encoded at a high quality than speech as it's got much more information in it. 'CD 
Quality' is 192kbps, but even on my iPod I only run at 96kbps when burning CDs. I've got pretty 
good gearing and can't really tell the difference between 96 and 192!

To encode the sermon, do 'File => Export as MP3', choose a location and click 'Save'. A window 
will then appear with some different options and boxes. These are known as 'tags' for the MP3 file 
and are used in programs such as iTunes and Windows Media Player and on MP3 players to tell you 
what the track/file is. The boxes are fairly self explanatory: the Title (of the sermon); the Artist (the 
Church); the Album (I put 'Sermons'); Track Number can normally be ignored for podcasts as it's 
not really relevant; the Year; the Genre is a bit more tricky, ideally you want 'Podcast' as that can 
help some MP3 players. But that's not in the list! You can use 'Speech' or use another program, such 
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as iTunes, to edit the tags (see the iTunes tagging section below). In Comments you can give the 
speakers name, Bible references, etc.

When you've entered the tags, click 'OK' and you're done! You now have a an MP3 ready for the 
web. However, you might want to tweak the tags or even add an image to the file. You can do these 
in iTunes.

Using Garageband (Mac only)

As in Audacity, in Garageband the audio is displayed in a wave form. However, editing it is done a 
bit differently!

Garageband makes more use of tracks and there are two views, the top 'tracks overview' (where all 
the tracks are listed) and then down the bottom you can turn on the 'Track Editor' (using the button 
that looks like a pair of scissors cutting a sound wave). This gives you a much larger view of the 
track to edit. You can zoom the tracks overview and the track editor by using the zoom bars on the 
bottom right of each view/pane.

Audio in Garageband are in a movable regions that you can drag around to the right time(s). 
Different types of audio are different colours. Imported music is yellow, 'software' instrument tracks 
are green and 'real' instrument tracks (including microphones) are purple.

Garageband defaults to bars and beats, but you can change it to time by clicking the 'LCD' monitor 
on the bar between the panes.

To move a region of audio put you mouse to the 'outer' side of the region so you've got a cursor 
that's a vertical bar with two little arrows either side; to click-drag for editing move it to the middle 
of the track so the cursor is cross-hair.

Editing out 'dead space' is similar to Audacity, click-drag to select a region of audio and hit the 
backspace button. Unlink Audacity, the audio doesn't close itself up, but leaves a gap. You can 
either move the two sections together (but be careful as if you over lap the audio on one side will be 
lost) or shift-click to select more than one region and 'Edit => Join' the regions together (if there's 
space between the regions, it will be be added as silence).

Fades are added using the 'Track Volume' bar (expandable using the little down arrow on the track 
name section). You can add points by clicking on the blue volume bar and then move them up and 
down to create fades, raise/lower volume, etc. So you can have two regions separated by a couple of 
seconds and put a fade out and in for them by making a 'V' out of points. To remove a point, click 
on it (so it gets a bit larger) and hit the backspace key.

To move/change the place head in Garageband click in the timeline in either of the panes.

For more on editing in Garageband see: http://www.apple.com/support/garageband/edit/

These are some more general tips on recording with Garageband: 
http://www.voiceovertimes.com/2008/01/04/10-tips-for-editing-a-podcast-in-garageband/

There's no 'noise removal' tool as such in Garageband, instead you can create effects on 'real' 
instrument tracks when recording them. These can especially useful when recording in a tape or 
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recording intros/outros. For more on using tracks in Garageband see: 
http://www.apple.com/support/garageband/tracks/

For recording intros and outros I use a 'Real Instrument Basic' track and put a few effects on it such 
a small amount of 'gate' and a small 'compressor'.

When recording in Garageband you need to set the input and output source. The settings for these 
can be found in 'Garageband => Preferences => Audio/Midi'. For more on recording intros/ourtos, 
see below.

If you're feeling really fancy, you can add 'chapters' to your podcast using Garageband. For more 
tips and how to add chapters see: http://www.apple.com/support/garageband/podcasts/recording/

When you've edited your sermon together, again you need to encode it to an MP3. In early versions 
of Garageband you used 'File => Export to iTunes'. This created a large AIFF file that was sent to 
iTunes for you to tag and convert to an MP3 (see below).

However, in iLife08 (Garageband 4) onwards, you can 'Share => Send Song to iTunes'. Like 
Audacity you can tag the MP3 file and choose the bit rate (by using the 'Compress' section and 
choosing MP3 and a preset or custom bit rate). You need to put something in all the boxes (like 
'Composer'), even if you then remove it later in iTunes (as I do!).

When the file has finished exporting it will open in iTunes in the playlist that you specified when 
'Sharing'. The MP3 file will be in your iTunes library in the 'Import' folder.

You can now finish tagging the file and even add an image.

Tagging MP3s in iTunes

iTunes is my program of choice for tagging MP3s as it's so easy to use. (If you've got a AIFF file 
from an early version of Garageband, you'll now want to convert the file to an MP3, by following 
the converting instructions in the first part of this series.)

To edit the tags on a file, find the file in iTunes and right-click => Get Info. In the 'Info' tab there are 
many boxes where you can add tags. I use the following: Name (for the title of the sermon); Artist 
(the Church); Album (Sermons); Genre (Podcast) and in Comments I put details of the speaker and 
Bible references, etc. (You don't seem to be able to add carriage returns/line-breaks in the comments 
box, so I write those details in a text editor and copy and paste them in!)

If you want to have a posh MP3 you can add an image to it. Adding an image means it appears as 
artwork on an iPod or in iTunes and just helps to brand your podcast. Ideally you want a square 
image that's 300x300px or 600x600px. It can be in a gif, jpg or png. You can either go to the 
'Artwork' tab, do an 'Add' and find your image; or if you open the artwork viewer in iTunes (it 
appears under the playlist, etc. section on the left and is opened by the right one of the four buttons 
at the bottom left of the screen) and when the MP3 file is playing you can drag an image file onto 
the artwork viewer box.
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Recording Equipment for Intros/Outros and other vocals

There are many options for recording intros and outros for you podcast (if you want to add them!). I 
think they help explain what's going on, especially if people are finding your podcast on iTunes or a 
podcast directory and so might not know about the Church.

I started using a webcam 'lapel' mic and some of these are very good (especially some of the USB 
ones) and with headsets being used more for applications such as skype, you can also use those. 
Many digital audio recorders and some MP3 players also have mics built into them.

If you want a top quality sound, you really need to use a 'proper' (condenser) or studio microphone.

Samson make a good quality USB Condenser microphone that's as easy to use as plugging in 
another USB devise! (http://www.samsontech.com/products/productpage.cfm?prodID=1810)

Or you can use a 'normal XLR' microphone with a mixing desk/audio interface (see the first part of 
the series for some of these).

I use a Studio Projects B1 Microphone: http://www.studioprojects.com/b1.html with a Behringer 
UB802 mixing desk: http://www.behringer.com/EN/Products/802.aspx and a Behringer FCA202 
Firewire interface: http://www.behringer.com/EN/Products/FCA202.aspx But I'm a geek and loves 
gadgets!

So hopefully now you've got an MP3 file ready to become a podcast. The next step is to put it 
online somewhere so the whole world can listen to it.

Putting the Sermons Online, Publishing them and Making a Podcast!

There are several ways you can do this! These range from 'all in one' services that do everything for 
you to doing everything yourself down to the last '.'!

We'll look at the different options so you can see what would best suit you needs.

Using an 'all in one' (that does the hosting, displaying and podcasting type things for you) 

Probably the easiest way to put the sermons online and create a podcast is to use an 'all in one 
service' which does everything for you.  You then get a player you can embed into the site. 

The two best options (in my opinion) are Sermon Player and Sermon Drop.

Sermon Player (http://sermon.net/theplayer.php) has a very good free package but does carry some 
christian ads on the free player.  These are a couple of (fuzzy) youtube vids on using it! 
http://youtube.  com/watch?v=YwqAPBWkz5I   
http://youtube.com/watch?v=vRw82Wyinak 

Sermondrop (http://sermondrop.com/ ) also has a free account where you can only have up to 10 
sermons on there at a 
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time, old ones are deleted automatically.  This might not seem many but it might be all you'd want 
on a site! The player is much more customisable with Sermondrop.

Both of these services take care of the hosting of the Sermons, gives you a player to put on your site 
and also make the podcast feed (more on those later!) and makes it iTunes friendly, etc.

Doing things manually!

If you're a control freak (like me!) and like to do things yourself here are some other ways... 

First, you'll need to put your mp3 somewhere online so people can listen to and download it.

The easiest place to put your MP3 files is on the same space/package/server where you host your 
Church website (normally uploading them by FTP). But unless you have a very big hosting package 
with lots of space and bandwidth allowances, you might find that you could quickly use this up!

You can upgrade your hosting package (which might cost!) or there's a special type of hosting 
offered by Amazon (yes the book people!) that can be excellent value for hosting media files (like 
MP3s).

The service is known as 'Amazon Simple Storage Service' (Amazon S3) http://aws.amazon.com/s3

Rather than having a 'lump sum' price, with S3 you pay for what you use (a combination of storage, 
bandwidth and requests for the files).  This can often work out much cheaper than 'normal' hosting. 
(I've got an S3 account with some images/MP3s/Videos and I get charged about $0.10 a month!)

This is a very good article explaining how S3 can be used for media hosting. 
http://developer.amazonwebservices.com/connect/entry.jspa?externalID=1073&ref=featured

As the article says, uploading items to S3 is done differently than using FTP and the 'S3Fox' Firefox 
plugin is excellent for doing the job. https://addons.mozilla.org/en-US/firefox/addon/3247

Also you can either have a long 'bucket' (folder) and file name such as: 
http://media.yourchurchsite.com.s3.amazonaws.com/sermon_01.mp3

Or if you (or your host) can manage your domain name settings, you can tie your bucket to the 
domain so the address would be: http://media.yourchurchsite.com/sermon_01.mp3

It's not as complicated as it sounds!

So now you've got your sermons online and ready to use, but you've got to make them available for 
people to listen to!

Publishing the Sermons online

Manually displaying the files
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Now you've uploaded the files you need to display them! If you want to do a really simple way, you 
can have a 'normal' link to an MP3 file, but that's not very exciting!

If you want a simple player with a list of sermons (in a 'playlist'), this is good: 
http://www.longtailvideo.com/players/jw-flv-player/

I use it for displaying the little player on the sermon pages. But it can take a bit of setting up. You 
can either play a single file or you can have a 'playlist' of files. 

Using Blogger 

Blogger (http://www.blogger.com), owned and run by Google, is designed as an easy to use' 
blogging' service, but can also do podcasting: http://help.blogger.com/bin/answer.py?hl=en-
il&answer=80259 

Here's another good blogger podcasting tutorial (it's a little old but still good!): 
http://www.churchcommunicationspro.com/2006/11/05/sermon-podcasting-made-easy/ 

With Blogger you can either use a 'blogspot' account (provided by blogger) to display the sermons, 
or you can edit the template and publish it to your own site/hosting.

Using Wordpress 

Wordpress is another popular option for bloggers/podcasters and two in two types, you can have a 
'hosted' account at: http://www.wordpress.com or you can download the wordpress software and 
install/run it on your own hosting: http://www.wordpress.org .  Wordpress can do more than just 
blogging/podcasting and can be used to run a whole site very easily.  My Church site, is completely 
run on wordpress: http://www.minehead-baptist.com

Here's a good post on the basics of running a Church site in wordpress (again it's a bit old but 
good!): http://www.churchcommunicationspro.com/using-wordpress-to-run-church-websites-
tutorial-series/

There are several good sites offering free wordpress themes that you can easily install, have a 
google for wordpress themes!

In Wordpress you can use 'plugins' to allow you to do extra things.  These are the best podcasting 
plugins:

PodPress (http://www.mightyseek.com/podpress): is widely used among podcasters and is good for 
general podcasting with Wordpress. It includes a customisable online player and iTunes feed 
support (more on that later).  I think it's best to have a category called 'Sermons' and put each 
sermon as a post within the category.

You can see a PodPress driven Wordpress site at: http://advent.lifespringonline.com/ (I'm the Brit on 
it!)

Podcasting (http://wordpress.org/extend/plugins/podcasting/): is quite similar to PodPress (but I 
think more elegant and easier to use!). It also has excellent iTunes support and makes podcasting 
very simple.
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Sermon Browser (http://www.4-14.org.uk/sermon-browser): is designed for podcasting Sermons 
by Mark Barnes, a Church Minister from Wales (UK).  This is a great plugin that really takes the 
work out of Podcasting sermons with Wordpress. You can add your Service Times, 
Preachers/Speakers and Sermon Series within the plugin settings, so adding a new sermon is a 
breeze.  It also features very customisable templates for how the sermons are displayed and there's a 
player (if you want one!). The sermons can also be filtered by users using a number of choices 
(such as date, preacher, series, book of the Bible, etc.).

When adding a new sermon you can either upload your MP3 using the plugin, enter a url of where 
you've already uploaded it (such as on S3) or even add 'embed code' from an external audio 
provider such as Odeo (www.odeo.com). You can also set Bible passages and the 
Service/Preacher/Series and a description of the sermon.

Rather than using a 'sermons' category, Sermon Browser uses a 'page' that displays the sermon. You 
can then click the title of the sermon to see more about it, view the Bible passage(s) and even hear 
the Bible passage(s)!

You can see a Sermon Browser driven Wordpress site at: http://www.bethel-clydach.co.uk/sermons/ 
(Mark's Church)

or if you're a geek like, you can Do It Yourself sung Wordpress!

Another way of podcasting with Wordpress, which is more 'techy' (and geeky!) and how I run the 
sermon podcast at my Church (www.minehead-baptist.com/sermons/), is to set it up for yourself!

It uses a few plugins, some javascript and custom Wordpress templates!

As this can get a little 'codey', rather than writing about it here, I've posted a 'how-to' over on one of 
my sites 'www.ministrypool.com'.  http://www.ministrypool.com/how-tos/diy-podcasting-on-
wordpress.html

But if you're looking for an easy and full featured way of podcasting sermons on Wordpress, I 
thoroughly recommend Sermon Browser. (If Sermon Browser had been around when I was 
developing my Church site, I would have used it!)

So we've got our sermons online and displaying nicely in Wordpress, blogger or on another type of 
site!.  But we want this to be a full blown podcast and that needs one crucial thing, a podcast 'feed' 
so people can subscribe to it!  That's what we'll be dealing with in the fourth and final part of the 
series.

Making a Podcast a Podcast!

If you want to 'podcast' the sermons (rather than just having them on the website) you need a 'feed'. 
This is the magic part of podcasts because the feed allows people to subscribe to the sermons (so 
new sermons come to them, rather than them having to visit the site every week.).

How to Podcast Sermons by James Cooper Page 10 of 12

http://www.ministrypool.com/how-tos/diy-podcasting-on-wordpress.html
http://www.ministrypool.com/how-tos/diy-podcasting-on-wordpress.html
http://www.minehead-baptist.com/sermons/
http://www.bethel-clydach.co.uk/sermons/
http://www.odeo.com/


If you've not come across 'feeds' before they are a way of finding out what's happening on a 
site/podcast without having to keep visiting the site. Most news based sites and blogs have feeds. 
They are also sometimes called 'news feeds', 'rss feeds' and 'xml feeds'. The common logo for feeds 
of all kinds is an orange square with three white curved lines 'broadcasting' out from bottom left to 
top right (insert feed logo here?!). But you also might see orange buttons with 'RSS' or 'XML' on 
them.

Here's a good post on CCP about feeds: http://www.churchcommunicationspro.com/2006/11/10/eat-
this-blog/

A podcast is a feed with audio (and/or video) 'enclosures' put into the feed. They're a bit like 
attachments on an email. To subscribe to podcasts you need a feedreader/podcatcher that can use 
podcasts. Two popular 'podcatchers' are iTunes (made by Apple and used with the iPod 
www.apple.com/itunes/) and Juice (http://juicereceiver.sourceforge.net/). You don't need an iPod to 
listen to podcasts!

Blogger, Wordpress (and the plugins mentioned above) are all good at making feeds for you. 

Make your feed better

Whatever feed(s) you have, I thoroughly recommend 'burning' the feed through an excellent free 
service called FeedBurner.

FeedBurner (http://www.feedburner.com/ also owned by Google) takes your original feed address 
and 'burns' it through their services. You then get a new feed address for the 'burned' feed. So for my 
Church, the original feed address is: http://minehead-baptist.com/category/sermons/feed and the 
'burnt' address is: http://feeds.feedburner.com/MBCSermons It's this new address that you make 
available to the world.

Perhaps the most import reason for podcasters to use feedburner, is that by using the 'SmartCast' 
service you can make the podcast feed very iTunes friendly.

Having a feed that iTunes likes is vital to people finding and using your podcast. You can add the 
podcast to categories within iTunes (like Religion & Spirituality >> Christian), add a summary and 
keywords for when people search the iTunes podcast directory and add a logo/image that will be 
displayed with your directory listing (the image is best if it's a 600px x 600px .jpg or .png file).

Let the World Know About Your Podcast!

Now you've got your nice new 'burnt' feed and a new feed address, but what to do with it?!

#1, add a link to the feed address on your Church site so people know that can subscribe to your 
podcast! (This might mean editing your sidebar or adding a widget.)

If you'd like a little feed icon to go next to your feed address to make it more prominent. You can 
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download a pack of feed icons from http://www.feedicons.com/. The excellent 'Silk Icons' set also 
has some nice feed icons and variations (for podcasting etc.) 
http://www.famfamfam.com/lab/icons/silk/

#2, add the feed address to the <head> section of the site. Doing this allows people who visit your 
site (using most modern browsers) to know that you've got a feed(s) for your site. (You might have 
noticed a feed logo - not always orange - on the right of the address bar when you visit a site. This 
appears because there's a special html tag in the <head> of the site/page that tells the browser that 
there's a feed(s).)

#3, add the podcast to iTunes and other podcast directories. This is relatively simple but you do 
need iTunes installed on your computer to add it to the iTunes directory. This page from the Apple 
site has got all the information you need: http://www.apple.com/itunes/whatson/podcasts/specs.html

When your podcast is added to iTunes, you can get a special link (to add to your site/sidebar) that 
will take users with iTunes directly to your listing. How to get it described in this post: 
http://www.hackszine.com/blog/archive/2007/01/make_shorter_itunes_podcast_li.html

The iTunes link for my Church is: http://itunes.com/podcast?id=77771498

Some other podcast directories you might want to add your podcast to include the Podcast Directory 
(http://www.podcastdirectory.com/), Podcast Alley (http://www.podcastalley.com/), Podcast Pickle 
(http://www.podcastpickle.com/) and Mevio (www.mevio.com/)

If you know of any other good podcast directories, please leave a comment!

Decisions Decisions!

So with all the options out there, what's best for you?!

Services such as the sermon.net and sermondrop do all the hosting, sorting out, having a player, 
creating the feeds/podcasts and the iTunes things for you! (So you don't have to use something like 
blogger, which is why I thought it might be easier for you!) You might want to add the tag in the 
<head> of the home / audio pages but that would be about it! 

I chose to use Wordpress to run my Church site because I was already very familiar with it and it 
does most of the work for me. Also I'm a geek and so wanted complete control every little detail! 

But for a simple Church site which you just want to add the sermons to, Sermon Player or 
Sermondrop could be just the thing you need and would be much easier than having to do 
everything 'manually'. It would be a matter of signing-up, and then copying and pasting the player 
info into the audio page. They would do the rest for you!
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